Basic Word 2007

Microsoft Word 2007 is word processing application software whose purpose is to help you create text-based
documents such as letters, memaos, reports or any other type of correspondence.

Loading (starting) the Word 2007 Program

There are several ways to start, or load the Word program. The two most common methods are by using the Start
menu (far left-bottom of the screen) or by clicking a desktop shortcut for the Word program if it is available. If you
use the Start menu, the steps will vary slightly depending on the version of Windows you are using. At this time,
we will load the Word 2007 program from the Start menu, and observe the screen layout.

Getting familiar with Word’s Screen Layout
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Note: Your screen will probably not look exactly like the screen shown. In Word 2007, how a window

displays depends on the size of your window, the size of your monitor, and the resolution to which your
monitor is set. Resolution determines how much information your computer monitor can display. If you
use a low resolution, less information fits on your screen, but the size of your text and images are larger.
If you use a high resolution, more information fits on your screen, but the size of the text and images are
smaller. Also, Word 2007, Windows Vista, and Windows XP have settings that allow you to change the

color and style of your windows.

NORTHBROOK PUBLIC LIBRARY — BAsic WORD 2007 — VER. 3 PAGE 1


http://baycongroup.com/word2007/01_word2007.html

Microsoft Word 2007 - Basic typing features

In this session we became familiar with the Microsoft Word window. This lesson covers typing, using the
Backspace key, using the Delete key, inserting text, bolding, underlining, and italicizing.

Type, Backspace, and Delete

In Microsoft Word, you create documents by typing them. For example, if you want to create a report,
you open Microsoft Word and then begin typing. You do not have to do anything when your text reaches
the end of a line and you want to move to a new line—Muicrosoft Word automatically moves your text to a
new line. If you want to start a new paragraph, press Enter. Microsoft word creates a blank line to
indicate the start of a new paragraph. To capitalize, hold down the Shift key while typing the letter you
want to capitalize. If you make a mistake, you can delete what you typed and then type your correction.

You can use the Backspace key to delete. Each time you press the Backspace key, Microsoft Word deletes
the character that precedes the insertion point. The insertion point is the point at which your mouse
pointer is located. You can also delete text by using the Delete key. First, you select the text you want to
delete; then you press the Delete key.

EXERCISE 1 - Type and Backspace

=

Type the following sentence: Joe has a very large house.

Delete the word "house." Using either the arrow keys or the mouse, place the cursor between the period
and the "e" in "house."

Press the Backspace key until the word "house" is deleted.

Type boat. The sentence should now read: "Joe has a very large boat."
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Delete

Delete the word "very" from the sentence you just typed.

1. Select the word "very." You can place the cursor before the "v" in the word "very," press and hold down
the Shift key, and then press the right arrow key until the word "very" is highlighted.

2. Pressthe Delete key. The sentence should now read:
"Joe has a large boat."

Insert

Make sure you are in Insert mode before proceeding. You are going to insert the word "blue" between the
words "large" and "boat."

Place the cursor after the space between the words "large" and "boat."
Type the word blue.

Press the spacebar to add a space.

The sentence should now read:

"Joe has a large blue boat."

PwnNE

Type the following: ~ =rand() then depress the “Enter” key
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The Text Area: Just below the ruler is a large area called the text area. You type your document in the text area.
The blinking vertical line in the upper-left corner of the text area is the cursor. It marks the insertion point. As you
type, your text displays at the cursor location. The horizontal line next to the cursor marks the end of the document.

Do you show the RULER on the screen?
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The Vertical and Horizontal and Vertical Scroll Bars: The vertical and horizontal scroll bars enable you to
move up, down, and across your window simply by dragging the icon located on the scroll bar. The vertical scroll
bar is located along the right side of the screen. The horizontal scroll bar is located just above the status bar. To
move up and down your document, click and drag the vertical scroll bar up and down. To move back and forth
across your document, click and drag the horizontal scroll bar back and forth. You won't see a horizontal scroll bar
if the width of your document fits on your screen.

Bold, Italicize, and Underline

When creating a document, you may need to emphasize particular words or phrases by bolding,
underlining, or italicizing. Also, certain grammatical constructs require that you bold, underline, or
italicize. You can bold, underline, and italicize when using Word. You also can combine these
features—in other words, you can bold, underline, and italicize a single piece of text.

Go to the “Home” tab, and then try the features found at the “Font” group. Bold, underline, and italicize
are found in the “Font” group within the “Home” tab.

EXERCISE 2 - Auto correct

Type the following exactly as shown. Press the “Enter” key after each item:

spoke atthe meeting
on sunday

saw what i saw

too broke dishes

PwnpE

Notice that Auto Correct fixed some problems (i.e., capitalizing “i”).
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EXERCISE 3 - Spell check - Type the following: (ignore the errors; just type what you see in the box.)

dear editor,

i am vory unhappy with the current parcking situation in schicago. The cost to pakr has tripled in price, so
i can nolonger afford driving into the citty. just thought you might want to no that i am one ungappy
voter, and all my fiends are nuhappy, two!

sincerely,

<Type your actual name here>

v To spell check the document: Click the “Review” tab, then “Spelling & Grammar”

The Ribbon (formerly the toolbars)
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The Ribbon is the panel at the top portion of the document. It has seven tabs: Home, Insert, Page Layout,
References, Mailings, Review, and View that contain many new and existing features of Word. Each tab is divided
into groups. The groups are logical collections of features designed to perform functions that you will utilize in
developing or editing your Word document. Commonly used features are displayed on the Ribbon, to view

additional features within each group, click on the arrow at the bottom right of each group.
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Each of the tabs contains the following tools (groups):

Home: Clipboard, Fonts, Paragraph, Styles, and Editing.

Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and Symbols

Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange

References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and Table of
Authorities

Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish

Review: Proofing (spelling and thesaurus), Comments, Tracking, Changes, Compare, Protect
View: Document Views, Show/Hide, Zoom, Window, Macros
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Quick Access Toolbar
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The quick access toolbar is a customizable toolbar that contains commands that you may want to
frequently use. You can place the quick access toolbar above or below the ribbon. To change the location
of the quick access toolbar, click on the arrow at the end of the toolbar and click on “Show Below the
Ribbon”.
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Mipimize the Ribbon

You can also add items to the quick access toolbar. Right click on any item in the Office Button or the
Ribbon and click on Add to Quick Access Toolbar and a shortcut will be added to the Quick Access
Toolbar.
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spemn|  Addto Quick Access Toolbar

Grame Customize Quick Access Toolbar...
Show Quick Access Tooloar Below the Ribbon
Mipimize the Ribbon
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The Status Bar: The Status bar appears at the very bottom of your window and provides such
information as the current page and the number of words in your document. You can change what
displays on the Status bar by right-clicking on the Status bar and selecting the options you want from the
Customize Status Bar menu. You click a menu item to select it. You click it again to deselect it. A check
mark next to an item means it is selected.

Custamize Status Bar
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The Microsoft Office Button - The round button found at the top-left of the screen

Recent Documents

1 Cuutiene

=] word Optjons || 3 Exdt Word

The Microsoft Office button performs many of the functions that were located in the File menu of older
versions of Word. This button allows you to create a new document, open an existing document, save or
save as, print, send (through email or fax), publish or close.
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Saving, Closing and Opening files

» Saving a File
o Office Button / Save — saves the current file to the disk with the same name that it was
previously saved under. The existing file on the disk gets replaced with the newer version.
o Office Button / Save As — saves the current file to the disk with a different name or
possibly just a different location. The original file (earlier version) is left unchanged on the
disk.
This option guarantees that the Save-As Dialog appears so you can make these changes.

Keyboard shortcut for Office Button/Save operation is Ctrl-S. You can also click the
Save button on the Quick Access Toolbar. Most filenames use letters, numeric digits, and
spaces but must be less than or equal to 256 characters.

o Once you save a document to disk, the name appears in the title bar at the top.
o Review Office Button / Word Options / Save to set the time for the AutoRecover
feature

» Opening a File
o Office Button / Open

o Open button on Quick Access Toolbar (drop down)
o Ctrl-O is the keyboard shortcut (Be sure to know this keyboard shortcut)

Exit Word

Typically, you save your work before exiting.

Very Important - Naming documents: Word 2007 and older versions of Word

All documents you create in Word 2007 have the extension “.docx”. The letters after the period are called
the file extension. An example of a file name and extension is: “Lesson One.docx”. If you choose not to
type “.docx”, the Word program will automatically include “.docx”.

Why is this important? If you plan to email a document to a friend who has an older version of Word, you
must save the file as “.doc” since prior versions of Word use the “.doc” file extension. If you will be
using the files you create on your computer, you could name the file as Lesson One only. The Word 2007
program will automatically add the extension .docx to the name. Therefore, on your computer, the name
of the file will appear as “Lesson One.docx”. 1f you want to save your file as an older “.doc” format,
when saving the file using the “Save as” option, choose “Word 97-2003 Document”.

Summary on file extensions

Older versions of Word (2003 and older) use the extension: .doc

Word 2007 file extension: .docx
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EXERCISE 6

Close and Save a file - Using Vista

r L L | .
lﬁ# @ Adkd-ns
1 New

Recent Documents

g AaBhb
== T Ha
Cpen
[}
b s
L'.‘Jc‘ Save A1 L
Prip ~that-are-desig
& & L
toansert-tables
S " sreate-piciures,
-4 Send L i
) cted-text-in-the
n-the-Home-tal
Pubkih b sntrols-offera-
ectiy.q
5 Busness Contad Manager P
L,- choose ngew-

rgallery,-use-th

("]

oo

z-galleny prowvie

@,ﬁ ¥ Ext Word | iginal-containe

1. Click the Microsoft Office button. A menu appears.

2. Click Exit Word, which you can find in the bottom-right corner.

Microsoft Office Word

(3)

i Dliyau want ta save the changes to Document1?

| Yes | Ho | Cam:all

3. You are prompted: "Do you want to save changes to Document1?" To save your changes, click
Yes. Otherwise, click No. If you click Yes, the Save As dialog box appears.

NORTHBROOK PUBLIC LIBRARY — BAsSIC WORD 2007 — VER. 3 PAGE 8



u.,\ |, ™ Business Computer * Documents ™ Sample P @ Eﬂ
File name |LE354'.‘I|'| Oinedoo: h[ 5 :| ﬂ
Save a3 fype: [Word Document (* doce) ;'
Authors: Busaness Compuber Tithe: Add = tithe
Tage: Add a tag Subgect: Specify the subject

[+ Save Thumbnail

4. Move to the correct folder.
5. Name your file by typing Lesson One.doc in the File Name field.
6. Click Save. Word saves your file.

Close and Save—Using Windows XP

1. Click the Microsoft Office button. A menu appears.

2. Click Exit Word, which is in the bottom-right corner.

3. You will be prompted: "Do you want to save changes to Document1?"” To save your changes,
click Yes. Otherwise, click No. If you click Yes, the Save As dialog box appears.

4. Specify the correct folder in the Save In box.

5. Name your file by typing Lesson One.doc in the File Name field. (Saving as older Word version)

6. Click Save. Word saves your file.

Open a file — Using Windows XP

1. Click the Microsoft Office button. A menu appears.
2. Click OPEN, and then select the file we just saved: Lesson One.doc in the File Name field.

Thank you for participating in Basic Word 2007 - Consider enrolling next in:

INTERMEDIATE WORD 2007: Covers formatting features including margins,
alignment, copy/cut and paste, inserting graphics and photos, and reviewing Word
templates.

NORTHBROOK PUBLIC LIBRARY — BAsSIC WORD 2007 — VER. 3 PAGE 9




